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Creating and correcting a layout

Task

In this exercise you will learn how to make a sheet layout from a 1up with the help of a wizard. The sheet
layout is then to be exported as a CFF2 file.

The complete layout
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Exercise description

In the first step we are going to create a layout from the 1up with the wizard.

Creating layout

1. On the File menu, click New. In the wizard that appears, click From Resizable Design.
2. Browse to C:\EngViewWork7, and click Toggle Flat Mode IEI

3. Type EVF11021, and select the file. Then click Finish.

The design opens.
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4. Go to the Layout tab to start creating a layout.
5. Do any of the following:

e Onthe Layout menu, click New Layout Drawing.

e On the Layout tab, click tool New Layout Drawing .
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The Select Layout dialog box appears.

< Select Layout @

(e Create new layout:

Name: |L390Ul

() Create blank

Switch to existing layout:

Restart lavout wizard

OK || Cancel | | Help

6. Click Run layout wizard, and then click OK.

7. To customize the layout, select the option User template from the pop-up menu Predefined template in
the Select Template window.

NOTE: The layout wizard forms an array of four layout 1ups, which is then multiplied across the sheet.
For more standard cases, the layout wizard offers predefined templates — 1x1; 2 rows, 2 columns, 2
parts in rows; 2 parts in columns.

NOTE: The buttons in the Rotation area let you rotate the layout 1up.
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< Automatic Layout @

&

Select Template Second Part Third Part Fourth Part Sheet Placement

Predefined template -
A~
2y [ User template b
Angle correction: IO_UU E %
Drawing-
Ba  [evenoz o
i~ Rotation

A — e ERE

RS S | > 5 | Next > i | Cancel | Help

8. To go to the Second Part window, click Next.

The second part appears aligned with the first.
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< Automatic Layout @

& o
Select Template Second Part Third Part Fourth Part Sheet Placement
» | Drawing
B [evenom -
:F!otation e —————
wie [ 2] [
'Horizon!aIAdiustment — _'
Move to: |ﬂ 'ﬂ
Align: |g \g’j ‘%J
Correction: 0.00 BD mm
Gap: 0.00 E mm
-Vertical Adjustment __
Move to: |1,J ‘g
Align: |U__[’]J l@ ‘@
Correction: 0.00 ED mm
: Gap: 18 f
3 i
@@@ < | > T~ | < Back || Next > || Apply “ Cancel || Help l

9. Click Next to go to the Third Part window. In this step you define the offset and the position of the next
layout row.
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< Automatic Layout @

& & ]
Select Template Second Part Third Part Fourth Part Sheet Placement
» | Drawing
By [evenoz -
- FRotation

o[£ 1] 2]
= Horizontal Adjustment :

Move to: |@ ‘E]

Align: |% \E‘ ‘.:._‘?'.1

Correction: WED mm

Gap: r— [

-Vertical Adjustment

Move to: |@ IE

Align: |E l@ ‘@
Correction: IEI.UU ED mm
Gap: IO.DIJ E mm
v -
@@@ < | > < Back H Nest > || Apply H Cancel || Help

10. Rotate the third part at 180 degrees (highlighted).
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< Automatic Layout @
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Select Template Second Part Third Part Fourth Part Sheet Placement

» | Drawing
By [evenoz -
- Rotation

o L)

- A Horizontal Adjustment

Move to: |E, JE

Align: |% \% ‘%‘
Correction: 0.00 BD mm
Gap: | mm

Vertical Adjustment

- 1 Move to: |§J ‘E
/ ‘ Align: |U—_[’]J |@ ‘@
Correction: -35.50 ED mm
Gap: ID.DU B mm
|
@@@ < | > | < Back || Next > || Apply || Cancel || Help |

11. To align the third part horizontally to the first part, in the Horizontal Alignment area, click the Align
Horizontal Center button (pictured). Then click the lines that will control the alignment: Line 1 and Line 2
(pictured). Upon clicking Line 2 the alignment is carried out.
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Line 1 Move to:
L Align:
- Correction:
/ Gap:
e \ -Vertical Adjustment __
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Note that in Correction, the distance of the alignment (-47.50) is displayed automatically.
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Align:

{En 1ewW Systems}
21X
Second Part Third Part Fourth Part Sheet Placement
» | Drawing
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Correction: -35.500 ED mm
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|
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12. Now we'll align the third part vertically up to the first part. In the Vertical Adjustment area, click the

Move Down IE.' button.

The third part attaches automatically to the first. In Correction, the value of the alignment (-71.00) is

displayed automatically.
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13. In Gap, enter a 5 mm for the gap between the first and the third parts.
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Angle: Ig ’E ’q |@
Horizontal Adjustment :

Move to: |E, JE

Align: |% \% ‘%‘
Correction: -47.50 BD mm
Gap: | mm

Vertical Adjustment

Move to: |§J ‘E
Align: |U__[’1J |E|_TEJ ‘@

Fourth Part Sheet Placement
Drawing
By [evenoz -
- Rotation

Correction: -71.00 BD mm
Gap: I ]5.00 B mm I
< Back || Next > H Apply H Cancel | | Help

14. Click Next.

The Fourth Part step appears.

In this window you can check how the rows and columns are arranged in relation to each other. You also
can correct the position and the alignment.
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< Automatic Layout @
Select Template Second Part Third Part Fourth Part Sheet Placement
» | Drawing
B8 [evenoz ~
Rotation

Angle: lg '@ ’q |§,

Horizontal Adjustment

Move to: |E, lE]

Algr: =] [&F] =]
Conection: [4750 [ | mm
Gap: oo K mm

Vertical Adjustment

a2 Move to: |E ‘E
Align: |E l@ ‘E_ﬂ

Correction: -71.00 BD mm
Gap: 5.00 B mm
\L*J'L—JL i
¥
RR > < Back || Next > ]| Apply H Cancel || Help

15. Click Next to go to the Sheet Placement step.

Sheet definition

In the second step we will define the sheet. There are three methods for this: (1) by fitting 1ups to a
predefined sheet; (2) by choosing an optimal sheet; (3) by calculating the sheet size according the
number of 1ups.

METHOD 1: Fitting lups to a predefined sheet size

A layout you create will be based on a custom sheet format User Defined. In the table you can check the
width, the height and the margins of the sheet and of the layout. The last column indicates a value that
you must add to the sheet format if you want to place another column or row.

You can enter your own values for the sheet
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< Automatic Layout @

&

Select Template Second Part Third Part Fourth Part Sheet Placement
» I Sheetl Layoutl +1 % |
Sheet Name User-defined
Width 1000.00 | 982.00 30350
Height 700.00| 518.00 59.00
Bottom 10.00 10.00
Left 5.00 9.00
Top 500| 17200
Right 5.00 9.00
| Statistics Calc Sheet | | Opt. Sheet...
(*) Fit to sheet |_| Rotated layout

(1 Fill by counts
[ H xom (TS
I 3 - Ygap I5.UU E

| Corrections...

|| Additional Optimizations

v

CEEEN < | 5 | <Back || Fiish || apply |[ Cancel || Hel

or click the Sheet column in the table to select the sheet format (pictured).

| Sheet| Layout | +172|
Sheet Name | -
}f@: HalfFarmat-L -~ ;
eight QuarterFormat-P 3
Bottom QuarterFormat-L
Left Bobst SP 76-E/-BM
T'_JD Bobst SP 102/3/4 Fast
Right Bobst SP 102/-E/-S/...
Bobst SP 102 -CE/ACE Il ...
Bobst SP 104-E/-ER
IR =N = Bobst SP 1230 et
, BobstSP142 R = _
= Bobst SP 162 v
(e} Fit to sheet ] Fotated lapout

When you select a different sheet format, the number of columns and rows will be recalculated
automatically and the 1ups will be positioned according to the selection.

135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14
inffo@engview.com www.engview.com



SIRMA GROUP COMPANY

1ewW Sy_stems}

< Automatic Layout

Select Template Second Part Third Part Fourth Part Sheet Placement

» [ I Sheetl Layoutl +1 2 |
[Sheet Name | BobstSP130[ [ |
Width 1310.00 128350 299.00
Height 925.00 744.00 60.00
Bottom 13.00 13.00
Left 2.00 8.25
Top 200 168.00
Right 2.00 8.25
I Statistics Calc Sheet | | Opt. Sheet...
(*) Fit to sheet || Rotated layout
1 ——/_m— /—{_1_\ f D_\ (1 Fill by counts
‘ l ] - Xagap: IL'I.UO E
J:/ I : ~ Y aap I5.UU B
| Corrections...
‘ .. L || Additional Optimizations
3| -
@@@ < | > | < Back || Finish I | Apply | | Cancel | | Help |

NOTE: To see an alternative layout array, rotated at 90 degrees counterclockwise, you can use the
functionalities for displaying statistical information and then choose whether or not to use rotated layout.

Select the Statistics check box. This changes the data in the table, displaying the alternatives in bold
case (pictured).

135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14
inffo@engview.com www.engview.com



few Systems}

Item I Straight ] Rotated l Item l Straight ] Rotated J
All Parts 12 10 All Parts 12 10
Area 0.799970 m"2 0.666642 m"2 Area 0.799970m"2 0.666642 m"2
Sheet Area 1.211750 m~2 1.211750m"2 Sheet Area 1.211750m"2  1.211750 m~2
Waste % 33.98% 44.99% Waste % 33.98% 44 99%

v Statistics Calc Sheet ] | Opt. Sheet... v Statistics [ Calc Sheet | [ Opt. Sheet...
' Fit to sheet |_| Rotated layout ') Fit to sheet v Rotated layout

Straight layout settings Settings for layout rotated at 90 degree.

METHOD 2: Defining sheet size by choosing an optimal sheet
1. Click the Opt. Sheet button below the table to run the wizard. This starts a method of sheet selection

that offers the sheet with least waste.
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Select Template

Second Part

Third Part

Fourth Part

Sheet Placement

I Sheetl Layout l +1 2 I
Sheet Name Bobst SP 130
Width 1310.00 128350 299.00
Height 925.00 744.00 60.00
Bottom 13.00 13.00
Left 2.00 8.25
Top 200 168.00
Right 2.00 8.25
[_iStatistics: CalcSheet ||| Opt. Sheet..
(*) Fit to sheet || Rotated layout
- 3 /_D_ D_\ (1 Fill by counts
‘ l X gap: ID.IJO B
| & ‘ —1;__\ - [ Y gap: [so0 K
‘ | Corrections...
| | | || Additional Optimizations
e M\
|
e o
@@@ < < Back || Finish H Apply H Cancel | | Help

2. In Optimal Sheet Selection: Input, specify the total number in the Number of pieces box.

Available sheets lists the sheets that you have.

TIP: To edit the list, on the Format menu, click Sheets, and then remove unnecessary sheet formats or

add new ones.

>
3. Select the respective sheets in the Available sheets list box and click the ‘J button to add them to
the list of selected sheets. The selected sheets appear in the right list box.
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%

w

Select Sheets

Bobst SP 130
Bobst SP 142
Bobst SP 162
Bobst SP 76-E/-BM
FullFormat-L

1310.00x525.00

1650.00x1133.00
776.00:572.00 mn

——— - -

[ Allow rotation of the layout

MNumber of pieces: |1 00000 BD
Available sheets:

A3-Landscape 420.002237.00 mn A
A3-Portrait 297.00x420.00 mn
Ad-Landscape 297.00=210.00 mn
A4-Portrait 210.00x297.00 mn
Bobst SP 102 -CE/CE Il ...  1030.00x715.00
Bobst SP 102/3/4 Fast 1040.00x725.00
Bobst SP 102/-E/-S/... 1025.00x715.00
Bobst SP 104-E/-ER 1050.00x746.00

1415.00:1020.00 B

1000.00x700.00 rr &

Selected sheets:

Select Best Sheet

|} Trim sheet's width by layout

[} Trim sheet's height by layout

| Next > || Cancel
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Select Sheets Select Best Sheet
Number of pieces: foooon 1|
Available sheets: Selected sheets:
A3-Landscape 420.00x237.00 mn A Bobst SP 130 1310.002325.00 mm
A3-Portrait 297.00x420.00 mn Bobst SP 142 1415.00:1020.00 mm
Ad-Landscape 297.00=210.00 mn Bobst SP 162 1650.00x1133.00 mm
A4-Portrait 210.00x297.00 mn
Bobst SP102-CEACE Il ...  1030.00x715.00 rr ‘ >
Bobst SP 102/3/4 Fast 1040.00x725.00
Bobst SP 102/-E/-S/... 1025.00x715.00
Bobst SP 104-E/-ER 1050.00:746.00 rr
Bobst SP 76-E/-BM 776.00x572.00 mn
FullFormat-L 1000.00x700.00 r
FullFormat-P 700.00:1000.00 ‘ o
HalfFormat-L 700.00=500.00 mn
HalFomalP 5000070000 m
|| Allow rotation of the layout || Trim sheet's width by layout || Trim sheet's height by layout

| Next > I | Cancel

>
NOTE: To select all available sheets, press the button }J . This sets ups all the sheets as possible
choices for the final sheet.

Allow rotation of the layout — the layout 1ups can be rotated to include optimization options.
Trim sheet's width by layout — trims the sheet according to the width of the used layout.

Trim sheet's height by layout — trims the sheet according to the height of the used layout.

4. Click Next to go to the Select Best Sheet window.

In this page the sheets are listed in descending order according to the percentage of waste area.

135 Tsarigradsko Shose Blvd., 1784 Sofia, Bulgaria
Tel: (+359 2) 976 83 13; Fax: (+359 2) 976 83 14
info@engview.com www.engview.com



few Systems}

< Optimal Sheet Selection: Result @

Select Sheets Select Best Sheet
Select the sheet that best suits your needs.
Name l Rotated I Sheets l Parts/Sheet l Parts l Waste Area l % |
Bobst SP 142 [No [ 6250 100000 2354208629 m"2
Bobst SP 162 No 5000 20 100000 2680.833629m™2 29
Bobst SP 130 No 8334 12 100008 3431.774815m"2 34
[ < Back l | Finish | | Cancel

The list box provides information on the number of required sheets, the number of 1ups per sheet, the
total number of pieces produced and the amount of waste for each selected sheet format.

5. Choose Bobst SP 142 list box, since this selection would result in the least waste; then click Finish.

In the selected sheet size, the program has fitted as many 1ups as possible.

METHOD 3: Calculating sheet size according the number of lups per sheet

In this method you enter the number of 1ups per sheet that you need. Then you use the Calc Sheet
button. The program computes the sheet size. During the computation, also the margins get taken into
account.
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&3

L & & e @&
Select Template Second Part Third Part Fourth Part Sheet Placement
» Sheet! Layout | +1 2 |
Sheet Name Bobst SP 142
width 1415.00 129350 194.00
Height 1020.00  970.00 191.00
Bottom 13.00 13.00
Left 2.00 60.75
Top 2.00 37.00
Right 2.00 60.75
,._{_1}_‘ I Statistics | Calc Sheet | ' QOpt. Sheet...
\ ‘ (e} Fit to sheet || Rotated layout
— \*1 ! Fﬁ—\ (1 Fill by counts
T | B I‘- ~ Xagap: IL'I.IJO B
' |1 = Ygap I5.IJU E
| Corrections...
‘ || Additional Optimizations
|
v VO R
v -
@R[ < | > | <Back || Finish || Apply || Cancel || Hep |

After you have chosen one of the three sheet size definition methods and have your final sheet size, click
Finish to complete the procedure.

The finished layout appears in the drawing area.
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File Edit Yiew Format Objects Transformations Dimensions Layout Tools Window Help

\EH 0| @ =IREUEY |~ |:[| Q. Objects ] 20 Transformations IIHIDimensions | 730 gBLayout |Print | EDiemaking | i Counterplate | LLCAM |
[EIREN & El 2 =) 5| 122 @
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|

1
1
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[7] [ 7] [$1E¥F11021 | 83 Layout

Click on object to select it, use CTRL to select a number of objects. Click and hold to begin multiple selection.

Recalculating a template

You may need to make corrections to the 1up to be able to fit more boxes into the layout. A standard
correction is the editing of the glue flap width. In this case, we will edit the width from 12 to 10 mm. This
affects the rule-to-rule width of the box (the overall horizontal dimension).

1. In the 1up drawing, change the expression of the GL parameter, which controls the width of the glue
flap, to 10.

TIP: Normally, to save space not all parameter groups are shown in the tabular area. To view a particular
group, right-click anywhere in the tabular area, point to Groups, and then on the context menu click the
name of the parameter group that you want visualized.
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< EngView Package Designer - [Creating Layout.evd] [:]g]
File Edit View Format Objects Transformations Dimensions Layout Tools Window Help
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) o
‘ =
: D <
8 E
IS =
& T
& L
' »
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: 3 s 00
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As a consequence of the editing a gap appears in the layout (pictured).
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< EngView Package Designer - [Creating Layout] B@@
File Edit Yiew Format Objects Transformations Dimensions Layout Tools Window Help - 8 X

‘@ ‘E ;@ |E {@ |§| |E [EH ‘Elbiits ]—QUTransfl?nniions_ 4Dimensions l@SD ]ELaymA ] Bl Print ]@Diemaking I‘ﬁCo\mterplake | U CaM I
el el WE B B B E D

Fom SN |

S Y S I

4

<

[$)EVF11021 | 83 Layout

[ [ee) 7]

i)
Sloping dimension. Keep SHIFT pressed to hold the mode

2. In the layout drawing, on the Layout toolbar, click Recalculate Template 'gl

The program updates the array with the new size of the box. The gaps are eliminated.
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. File Edit View Format Objects Transformations Dimensions Layout Tools Window Help

=l D)= [ (@)l & |j_| SO l €0 Transtomatons. | feaDimensions | (30 mLayout IlPrint I@Piemakhg IHCMerpiake ] Lo |
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[7] [ 7] [$1E¥F11021 | 83 Layout

Applying layout to a new sheet

When you have a template-generated layout, you can later apply a new sheet to the already-defined

array of the boxes. To do so, on the Layout toolbar, click Apply Layout Template to New Sheet |
and then, in the dialog that appears, proceed with the definition of the sheet.
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< Apply Layout Template To New Sheet @
2o | Sheet I Layout l +1 7 |
Sheet Name Sh17
Width 1297.50 1287.50 303.50
Height 985.00  970.00 226.00
Bottom 13.00 13.00
Left 2.00 5.00
Top 2.00 2.00
Right 2.00 5.00
[_JiStatistics: Calc Sheet ] | Opt. Sheet...
(o) Fit to sheet || Rotated layout
() Fill by counts

[T Xoap oo H
[— Y gap: WB |

| £

|»

SRR «

| 0K H Apply ]| Cancel H Help |

The application of the new template can be carried out by using any of the three sheet definition methods
described above.

Exporting layout in the CFF2 file format
The layout drawing can be exported as an CFF2 file.
1. Make sure the Layout window is shown.

2. Choose File > Export.
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< EngView Package Designer - [Creating Layout.evd]
§cW Edit Yiew Format Objects Transformations Dimensions Layout Tools Window Help

e z::n E::::g | ©-Dbects | g9 Transfomations | kiDimensions | (93D gLayout | EJPiint | [Diemaking | FjCounterplate | L CAM |
K [

|E Import as Mew Project... ,‘ | | | ’E ‘ |§J |_| |Ei
; Insert Drawings. ..

F Import Into Current Project. ..
. Find Matching Standard...

~
|: Close - - 0
Save Chrl+S /—{:}
| | R ; L
| saveal
Export... Ctrl+E
Print Preview...

PHnt... Ctri+p H ‘l \_)L EE g S

Properties. ..

1 C:\...D\Creating Layout
2 C:i\...cise S\Exercise 4
3 D:\...op\Sample Counter

4 EYF12041 Gusset Carri... H
S EVF11021 Straight Reg...
6 C:h...ercise 3\Projectl

7 C:\...cise 8\Exercise 8
8 C:\...DiVarnish Blanket

Exit Alt+F4

< m
(7] [=| 7] [BEVF11021| B8 Layout 4
Saves the active drawing under a new name

The Export dialog box appears.

3. Choose the option Common File Format CFF2 in the pop-up menu File of type and save the file to the
proposed folder.
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< Export @
Look in: | £ CFF2 >~ B e E-

|@]EYF11021 User Design

File name:  |Creating Layout | Save |
Files of type: ICommon File Format CFF2 [*.cf2; cff) - | Cancel l

| Hep |

Attach to PO Project

[w4 Export dimensions

Export rules: lDefauIt Filters ]v | Line types...
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